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Reports Module

The Reports Module provides an easy-to-use tool to analyze data, including
compliance measures and database configuratfion.

The Reports Module is accessible from the vertical toolbar link within
Guardian. This link is visible to all users who have Report access. Visible
report types and report functionality are dependent on user privileges.

Two types of reporting functions are offered: Standard and Interactive.

» Standard reports are pre-configured templates that provide useful
information associated with I-9s, E-Verify, and FAR.

> The Interactive report type is a comprehensive reporting tool allowing for
extensive customization of report columns and filter criteria.
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Reports Module

> Administrative settings will determine if users will have access to
creafing, editing and deleting reports.

> Report types and report functionality are dependent on user privileges.

> User privileges for the general report module as well as the Interactive
report type are determined by organization administrators.

> Report privileges may be set globally or at the user level, allowing
organizations to determine who may access reports as well as who can
create and/or edit reports.
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To access the Reports Module,

Reports Module Access click on the Reports tab

on the Dashboard.
Guardian Announcements Help + Denise Mareno Logout

Dashboard Start -9 Employee E-Verify Reports
@ Employee Group Western US i Refresh All Type of 1-9: Current | Imported
() Location Create New Employee
Top Pending I-95 ~  Top I-95 Needing Approval ~
¥ view @& Al 3 rze  view % An
T Date -9 Location Employee Name Status Section 1 Section 2 Date I-9 Location Employee Name Employee Start Approval E-
Created Deadline Deadline Created Date Verify Deadline
@& os122020 Portland: Moore, David Signad Sec 2 08/18/2020 08/21/2020 @ o9/09/2020 Portland: Salak, Tim 06/03/2020 06/09/2020
@&  o9/09/2020 Portland: Nestor, Sabina Started 09/04/2020 09/10/2020 & o09/09/2020 Portland: Adams, Sam 09/04/2020 09/10/2020
. E 08/28/2020 Portland: Brady, Sam Signed Sec 1 09/16/2020 09/21/2020 ) 08/18/2020 Los Angeles: Jones, Robert 09/17/2020 09/22/2020
JE 09/18/2020 Phoenix: Jones, Steve Started 09/18/2020 09/23/2020 & 08/07/2020 Los Angeles: Tucker, Marshall 10/01/2020 10/06/2020
@c Portland: Sanchez, Samuel Started 09/21/2020 09/24/2020 o 08/26/2020 Phoenix: Brady, Marcia 10/01/2020 10/06/2020
PE Portland: Chavez, Donald Started 09/21/2020 09/24/2020
$E Portland: Michaels, Sandra Started 09/25/2020 09/30/2020
W E 09/02/2020 Phoenix: McNeil, Mary Started 09/30/2020 10/05/2020 <
Top I-95 Needing Further Action v  Top Pending Re-Verifications v
2 viewn & Al P view Al %jp Analyze
Date I-9 Location Employee Names Reason Date Expires Days Left Date I-9 Location Employes Name Expiration Date Days Left
Created Created
o 08/17/2020 Portland: Davis, Steve Receipt 12/15/2020 83 2 08/17/2020 Phoenix: Lopez, Deborah 10/10/2020 18
) 09/14/2020 Portland: Bennett, Susan 11/25/2020 64
- 09/21/2020 Portland: Stevens, Justin 12/31/2020 100
- 08/17/2020 Portland: Duncan, Sandra 12/31/2020 100
) 08/28/2020 Phoenix: Stevens, Brent 02/15/2021 146
") 09/09/2020 Portland: Milbarge, Joe 08/01/2021 313
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Reports Module Access

Report Types shows Interactive and
Standard report types.

Guardian

Dashboard

All Types
Interactive

Pending Reverifications

19 Issues Standard Reports

Employee Groups

Reports: All Types [Mine]

Mame Created by

Interactive (10037) Moreno, Denise

Pending Reverifications (10096) Moreno, Denise

Timeliness Report Moreng, Denise

Start1-9

Announcements Help + Denise Moreno « Logout

Employee «» E-Verify

# | Report Details & Settings

'/ Help with Reports

On the left are two lists.
+ The top list, Report Types, shows all of the various report types that can be created.
+ The lower list, Reports:, shows the reports available for viewing (based on the report type and filter selected)

Report Types

= Click on any desired report type to see all reports of that type.
+ Click All Types to see all reports, regardless of type.
+ To create a new report, first select the desired report type from the list, then click the New button in the list of Reports: shown.
Reports
= You can use the Filter menu to restrict the list of reports to:
+ All - show reports of the selected type
+ Shared - show reports that have been shared by users
* Mine - show reports created by you
+ Others - show reports created by everyone but you
+ Private - shows private reports created by you
+ Click any report to view it, update it, or change it's parameters.
« Click the Refresh button to update the list of available reports
+ Click the Reports menu to:
« Duplicate - duplicate the currently selected report
+ Delete - delete the currently selected report
+ Click the New button (if enabled) to create a new report of the selected type in the Reports Types list
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The Reports sections displays any

R6p0rfs Module Access reports created for the selected

. Report Type above.
Guardian e

Dashboard Start1-9 Employee «» E-Verify

Report Types # | Report Details & Settings

All Types Hel R y
Interactive o Help with Reports
Pending Reverifications

[-9 [ssues
On the left are two lists.

+ The top list, Report Types, shows all of the various report types that can be created.
+ The lower list, Reports:, shows the reports available for viewing (based on the report type and filter selected)

Employee Groups

Report Types
= Click on any desired report type to see all reports of that type.
+ Click All Types to see all reports, regardless of type.
+ To create a new report, first select the desired report type from the list, then click the New button in the list of Reports: shown.

- Reports
Reports:JAll Types [Mine] -
= You can use the Filter menu to restrict the list of reports to:
¥ Fiter ~ ' Refresh B | + All - show reports of the selected type
Name Created by + Shared - show reports that have been shared by users
* Mine - show reports created by you
+ Others - show reports created by everyone but you
+ Private - shows private reports created by you
+ Click any report to view it, update it, or change it's parameters.
« Click the Refresh button to update the list of available reports
+ Click the Reports menu to:
« Duplicate - duplicate the currently selected report
+ Delete - delete the currently selected report
+ Click the New button (if enabled) to create a new report of the selected type in the Reports Types list

Interactive (10037) Moreno, Denise
Pending Reverifications (10096) Moreno, Denise

Timeliness Report Moreng, Denise
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Filter Options

All - Shows all reports (only
accessible by Admin users)

Report Module Filters

Guardian
Dashboard Start -9 Employee » E-Verify Mine - ShOWS G” reporTS CreOTed
by the user

e ¥ Help with Reports Others - Shows reports created by
other users

Report Types # | Report Details & Settings

[-9 [ssues
On the left are two lists.

* The top list, Report Types, shows all of the various report types that can be created.
+ The lower list, Reports:, shows the reports available for viewing (based on the report type and filter selected)

Employee Groups

port Types

Click on any desired report type to see all reports of that type

Click All Types to see all reports, regardless of type.

To create a new report, first select the desired report type from the list, then click the New button in the list of Reports: shown.

ports
You can use the Filter menu to restrict the list of reports to:
+ All - show reports of the selected type
All ' + Shared - show reports that have been shared by users
Mine * Mine - show reports created by you
Others + Others - show reports created by everyone but you
+ Private - shows private reports created by you
Click any report to view it, update it, or change it's parameters
Click the Refresh button to update the list of available reports
+ Click the Reports menu to:
« Duplicate - duplicate the currently selected repart
+ Delete - delete the currently selected report
+ Click the New button (if enabled) to create a new report of the selected type in the Reports Types list

Reports: All Types [Mine

Ei Filter w= r:' Refresh

Interactive (10037)
Pending Reverifications (10096

Timeliness Report Moreng, Denise
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To create a new report, first select

Report MOdUIG Types the desired Report Type above, and
Guardian then click the New button.

Dashboard Start I-9 Employee v E-Verify

O All Types o Help with Reports

Interactive
pending Reverifications On the left are two lists.
« The top list, Report Types, shows all of the various report types that can be created.
1-0 Issues « The lower list, Reports:, shows the reports available for viewing (based on the report type and filter selected).
Employee Groups

« Click on any desired report type to see all reports of that type.
« Click All Types to see all reports, regardless of type.
’ g « To create a new report, first select the desired report type from the list, then click the New button in the list of Reports: shown.

P—— [ ——
« You can use the Filter menu to restrict the list of reports to:
= All - show reports of the selected type

B Filter = Refresh %t Report - [l vew

Nama Created by + Mine - show reports created by you
« Others - show reports created by everyone but you
‘ ‘ ot » Click any report to view it, update it, or change it's parameters.
« Click the Refresh button to update the list of available reports
User Creation_LLX Xx, Lawlogix + Click the Reports menu to:

« Duplicate - duplicate the currently selected report
+ Delete - delete the currently selected report
+ Click the New button (if enabled) to create a new report of the selected type in the Reports Types list
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Standard Reports
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Guardian

Dashboard

Report Types
All Types

Interactive

Pending Reverifications

[-9 Issues

Employee Groups

Reports: All Types [Mine]

N Fier ~ v:' Refresh

Name

Interactive (10037)
Pending Reverifications (10096)

Timeliness Report

Standard Reports

Start -9

Created by

Moreno, Denise
Morenao, Denise

Moreng, Denise

~

Employee «» E-Verify
Report Details & Settings

‘/ Help with Reports

On the left are two lists.
* The top list, Report Types, shows all of the various report types that can be created.

+ The lower list, Reports:, shows the reports available for viewing (based on the report type 3

Report Types
« Click on any desired report type to see all reports of that type
+ Click All Types to see all reports, regardless of type.
+ To create a new report, first select the desired report type from the list, then click the New b

Reports
= You can use the Filter menu to restrict the list of reports to:

+ All - show reports of the selected type

+ Shared - show reports that have been shared by users

* Mine - show reports created by you

+ Others - show reports created by everyone but you

+ Private - shows private reports created by you
+ Click any report to view it, update it, or change it's parameters
Click the Refresh button to update the list of available reports
+ Click the Reports menu to:

« Duplicate - duplicate the currently selected repart

+ Delete - delete the currently selected report

Standard Reports - types include:

Pending Reverifications: employees
with temporary work authorization
that require reverification.

I-9 Issues: employees who have
issues flagged on their primary
-9 record.

Employee Groups: displays details
about the organization’s locations
and employee groups.

+ Click the New button (if enabled) to create a new report of the selected type in the Reports Types list
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Standard Reports

Guardian

Dashboard Start -9 Employee » E-Verify
Report Types A  Report Details & Settings
Al Types Report Information
Interactive Report Type: Pending Reverifications
1 Created by: Moreno, Denise : 09/22/2020 @ 11:00:54
L9 s Last Run: This report has never been run
Empl G »
mployee Groups Report Settings 3
Report Name: = Pending Reverifications (10156[g]
Filter Options 4
Employee Group: | My Managed Groups
Location: | All
Reports: Pending Reverifications [Mine] 2 Employee Status: | All

D Fier ~ v:' Refresh 'b Report (= New

Qe tanse 35

Name Created by
v From:
To:
Pending Reverifications (10096) Moreno, Denise
Pending Reverifications (10155) Moreno, Denise Auto Calc: =

Pending Reverifications (10156) Moreno, Denise

Sort Options

Primary Sort:

e s> 6

Employee

Standard Reporis process:
1) Choose Report type

2) Click New

3) Name the report

4) Select desired Filter Options

5) Specify Date Range (optional)
6) Click the Update Settings button
/) Click the Run Report Now button

Value Date Range
-30 Last 30 days

Value Date Range
60 Next 60 days

m This Month -m Last Month
6m 6th Month

q This Quarter -q Last Quarter
2q Second Quarter

y This Year -y Last Year

* If the HR Filter Group is specified, it will be used instead of the Responsible HR Filter.

Run Report Now 7
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Once the report runs, results may be

qundqrd Reports viewed within Guardian or

downlooded ’ro Excel

Guardian

Dashboard Start 1-9 Employee - E-Verify

Report Types 4 | Report Details & Settings

AT .
vpes Report Information

Interactive
Report Type: Pending Reverifications

Created by: Moreno, Denise : 09/08/2020 @ 08:22:39
Last Run: (j 02

Pending Reverifications

I-9 Issues

Employee Groups

) -
Download Excel Report

Report Name: | Pending Reverifications (10096[]

Report Settings

Filter Options

Reports: Pending Reverifications [Mine] Employee Group: | My Managed Groups X
M Fier ~ Refres eport v Qg New Location: | Al =
Name Created by
Employee Status: | All .
v
Date Range
Pending Reverifications (10096) Maoreno, Denise
Value Date Ran Value Date Rani
Pending Reverifications (10155) Moreno, Denise From: T Emiaal - 1 [ e dge
- ays ays
Pending Reverifications (10156) Moreno, Denise . m This Month _m Last Month
H
6m 6th Month
. q This Quarter -q Last Quarter
Auto Calc: 2q Second Quarter
y This Year -y Last Year

Sort Options
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Interactive Reporis
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Interactive Reports & Base Tables

Interactive reports provide the most flexibility within the system and are
modularized so that the user can choose which fields to include in the
report. When creating an interactive report, different views of the data
have been pre-established so that the resulting information relates 1o a
Base Table. Base Tables and are selectable via the dropdown.

Once the Base Table is established, the report consists of three tabs:
Settings (filter options), Columns (content selection), and Preview (example
of report output). The Column tab utilizes drag and drop functionality,
allowing the user to select the type of fields to include, and identify the
specific data points to extract.
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Base Tables

The following list defines the Base Table use case for Interactive Reports:

» HR Users: this is the main table to pull information related to a user
> Business Units: this table pulls information related to business units

» Contracts: this table will pull information related to all contracts
>

Dashboard: this table will generate reports from any of the available
dashboard panels (see the Dashboard Reports slide for more information)

A\

Documents: this table will pull information related to any items in OnDocs.

A\

E-Verify: this table will pull information from any E-Verify cases

> Employee Address: this table will generate reports related to employee’s
address
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Base Tables

> Employee Group Assignments: this fable will identify which Employee
Groups the user is assigned to

Employee: this table will pull information related to all employees

FAR: this tfable will pull information related to FAR

I-9 Issues: this table will pull information related to any existing I-9 issues
I-9 Section 3: this table will pull information related to all Section 3's

1-9: this table will pull information related to any existing 1-9's

vV V VYV VYV VY VY

Locations: this table provides a yes/no indicator of which user is the
default user for the HR Group
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Base Tables

> Multi-Business Units: this table will identify which Multi-Business Units the
user is assigned to

> Remote Agents: this table will pull information related to all Remote
Agents used in processing Section 2's

> Remote I-9s: this table will pull information related to any remote [-9s

> State Affidavits: this table will pull information related to any State
Affidavits

> Tasks: this table will pull information related to all pending Tasks
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Dashboard Reports (Dashboard Base Table)

The Dashboard base table is intended to supplement the dashboard
interface available to full featured users. This is particularly useful for
organizations that exceed the number of maximum results visible within the
dashboard view, or who are in need of more information at-a-glance in
order to make decisions and take action (e.g. which location or group is
assigned to each result).

When a dashboard filter is applied only those employees meeting the filter
selection are included in the report. As an example, if Top Pending I-9s is
chosen, only those employees with an in-process |-? that has not been
marked Complete will appear in the results.
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Dashboard Reports (Dashboard Base Table)

Users can narrow results based on the organization’s configuration or
simply include corresponding report columns. This report type searches
against active employees, and is optimized for organizations that have
migrated historical I-9s as the results include employees from both

the Current and Imported dashboard views.

Users are not able to narrow the results by employee status, I-92 form type,
-9 error type, or scope.

Users can add dashboard specific columns to the report, or pull in standard
information for the employee, I-9, or E-Verify record. The dashboard table
includes those pieces of data found in the dashboard interface.
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Dashboard Base Table Report

The Dashboard Interactive report allows users to filter by available
dashboard views:

» Top Pending I-9s: any |-9s pending completion
» Top Pending Tasks: any pending tasks
» Top Pending I-9 Issues: any pending I-9 Issues

> Top New Hires and Rehires without I-9 or Section 3: any employees with out
an |-9 or Section 3

» Top Pending Re-Verifications: any reverifications

> Top I-9s Needing Further Action: any I-? needing further action
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Dashboard Base Table Report

> Top Pending E-Verify Actions: any E-Verify cases with pending actions
> top I-9s Needing Approval: any I-9s pending approval

> Top Amended I-9s needing Employee Approval: any amendments to
Section 1 that are pending Employee’s approval

> Top Amended I-9s needing HR Approval: any amendments to Section 2
that are pending HR/user's approval
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Interactive Reports provide additional

Interq Cﬁve Reporis report columns and filter options not

available from Standard Reports.

Guardian

Dashboard Start 1-9 Employee » E-Verify

Report Types #~ | Report Details & Settings
All Types "

J Help with Reports
Pending Reverifications
I-9 Issues

On the left are two lists.
* The top list, Report Types, shows all of the various report types that can be created
« The lower list, Reports:, shows the reports available for viewing (based on the report type and filter selected).

Employee Groups

Report Types

+ Click on any desired report type to see all reports of that type.

+ Click All Types to see all reports, regardless of type

« To create a new report, first select the desired report type from the list, then click the New button in the list of Reports: shown.

Reports

+ You can use the Filter menu to restrict the list of reports fo:
+ All - show reports of the selected type

Name Created by + Shared - show reports that have been shared by users

* Mine - show reports created by you

s Others - show reports created by everyone but you

+ Private - shows private reports created by you

Reports: Interactive [Mine]
W Filter ~

Interactive (10037) Mareno, Denise « Click any report to view it, update it, or change it's parameters.
Il () 3TN, [DITES « Click the Refresh button to update the list of available reports
Timeliness Report Moreno, Denise

« Click the Reports menu to:
+ Duplicate - duplicate the currently selected report
* Delete - delete the currently selected report
+ Click the New button (if enabled) to create a new report of the selected type in the Reports Types list




Interactive Reports - in the

Intera Cﬁve Reports Report Settings section:

Report Name - customizable

Guardian

Dashboard Start -9 Employee » E-Verify

Settings

Base Table - select what record
type to be reported on

Report Types ~

_ | Repertnformation Private — uncheck to allow other
o I‘Esis CT:::S: ?10reno, Denise : 09/22/2020 @ 13:22:51 Users 'I'O Occess your repor'l'
(Admins can access all reports,

regardless of this setting.

Rows X Columns: Q0 X 0
This report has never been run

Report Settings

Report Name: | Interactive (10158) [[] 10158

Base Table:
Reports: Interactive [Mine] (Cannot be changed once selected)

M Fiter ~ {' Refresh wv EL N + EN

= If the HR Filter Group is specified, it will be used instead of the Responsible HR Filter.

Mame Created by
Update Settings
v
Interactive (10037) Moreno, Denise
Interactive (10154) Moreno, Denise
Interactive (10158) Meoreno, Denise
Timeliness Report Mareno, Denise
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To generate an Interactive report,

I n’rel‘Cl Cﬁve REPO”S select the report type in the upper

section and click the +New button.

Guardian

7 Name the report and select the
pashboare sttt Fpleyee ey Base Table from the dropdown menu.

Report Types ~ Settings

All Typ .
= 1 Report Information

Report Type: Interactive
Created by: Moreno, Denise : 09/22/2020 @ 13:22:51
Last Run: -

Pending Reverifications
-9 Issues

Employee Groups
Rows X Columns: 0 X 0

This report has never been run

ReponNarG' Employee Report >: 10158

Report Settings

Base Table| 3

Reports: Interactive [Mine] 2 -
r . 4 Employee

ilter v W_ Refres eport (x New

Filter %" Refresh " Report hd New * If the HR Filter Group is specified, it will bl FAR

Name Created by
Update Settings 19 Issues
v
19 Section 3
Interactive (10037) Moreno, Denise 19
Interactive (10154) Morengo, Denise L ocations
Interactive (10158 Moreno, Denise : ;
L ) - Multi-Business Units

Timeliness Report Morenao, Denise -l
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To general the report automatically

Interactive Reporfs a continual basis, choose the

Guardian

Dashboard Start -9

Report Types

All Types

Interactive

Pending Reverifications
-9 Issues

Employee Groups

Reports: Interactive [Mine]

W Fiter v e‘ Refresh '& Report = B New

Name Created by
Employee Report Moreno, Denise
Interactive (10037) Moreno, Denise
Interactive (10154) Moreno, Denise
Timeliness Report Moreno, Denise

frequency in the Scheduler Options
section by choosing Daily, Weekly
Employee v E-Verify or Monthly options.

Settings Columns Preview

Report Information The Daily opfion will run the report
ReportType: Interactive either All Days or Weekdays only.

Created by: Moreno, Denise : 09/22/2020 @ 13:22:51
Last Run:

iﬂm X ) The Weekly option will run the report
s repm‘t as Never been run

on the same day of the week on a
weekly basis.

Report Settings
Report Name: | Employee Report [f] 10158

Base Table: Fmployee

The Monthly option will run the
cormt ity | P _ report on the specified day
. of the month.

Filter Options
Every 1 Day of The Month

" Empleyes Grouns - eyery 2 Day of The Month

Scheduler Options @

Employee Location-§  Every 3 Day of The Maonth
Every 4 Day of The Month
Every 5 Day of The Month
Every 6 Day of The Month
Every 7 Day of The Month

Employee:
Emp Employee Exemption:

Emp Employee Designation:
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Once the Base Table is selected,

Intequflve Reports two new tabs become visible;

Columns and Preview.

Guardian

Dashboard Start -9 Employee » E-Verify

Report Types ~ Settings I Columns Preview I
All Types .

P Report Information
Interactive

Report Type: Interactive
Created by: Moreno, Denise : 09/22/2020 @ 13:22:51
Last Run: -
Rows X Columns: 108 X 0

Pending Reverifications
-9 Issues

Employee Groups
This report has never been run
Report Settings

Report Name: | Employee Report [f] 10158

Base Table: Fmployee

Reports: Interactive [Mine]

Scheduler Options @

Name Created by Generate Automatically: | Monthly v
o Days To Run: | Every 1 Day of The Month v

Employee Report Moreno, Denise Filter Options

Interactive (10037) Moreno, Denise

Interactive (10154) Moreno, Denise Employee Group: | My Managed Groups ht
Timeliness Report Moreno, Denise Employee Location: All =
Employee: | All v
Emp Employee Exemption: | All v
Emp Employee Designation: | Al v
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. The Columns tab displays the
Infequflve Reports available tables and fields, and data

selection in these areas determine
formatting and the specific

pashtoard srate Employee ¥ E-Verify information generated in the report.
Report Types ~ Settings Preview

Guardian

All Types -
e Tables & Fields
Interactive
Pending Reverifications 1) Select Table 2) Select Field 3) Build Fields in Report 4) Column Settings
18 Issues @ Field N Field N
ield Name ield Name sl
Employee Groups Field:
EMpTTee Data Type:
I-9
E-verify Format:
Locations Align:
Businass Unit
Login
Reports: Interactive [Mine]
W Fiter v x." Refresh “ Report = B New
Name Created by y
~
Drag selected field to report Drag within list to change order
Employee Report Moreno, Denise
Interactive (10037) Mareno, Denise Refresh Field List Remove Field(s)
Interactive (10154) Moreno, Denise
Timeliness Report Moreno, Denise

Update Settings
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Guardian

Dashboard

Report Types

All Types

Interactive

Pending Reverifications
I-9 Issues

Employee Groups

Reports: Interactive [Mine]

Interactive Reporis

Start -9

N Fitter ~ (" Refresh “ Report v [ New

Name

Employee Report
Interactive (10037)
Interactive {10154}
Timeliness Report

Created by

Moreno,
Moreno,
Moreng,

Moreno,

, Denise
, Denise
, Denise

, Denise

Fmeloves Eiverifv

Setlings Columns Preview
Tables & Fields
1) Select Table 2) Select Field 3) Build Fields in Report

Field Name Field Name

Employee Employee Guardian ID

Date Created

E-Verify First Name
Locations Middle Name
Businass Unit Last Name

Login Other Names Used

Employee Name

Employee Phone Number

Title
Date of Birth
Sodial Security Number -
4 3
Drag selected field to report Drag within list to change order
Refresh Field List Remove Field(s)

Update Settings

The 1) Select Table section lists the
tables from which the user can
select fields. Click on the desired

item in the column. This may include
one or more fables in addition
to the base table.

4) Column Settings

Field:
Data Type:
Format:

Align:
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Click the desired table to display

|n'|'erC|C'|'ive Reporis a list of available fields in the

2) Select Field area.

Guardian

Dashboard Start -9 Employee » E-Verify

Report Types ~ Settings Columns Preview
AllTypes Tables & Fields
Interactive
Pending Reverifications 1) Select Table 2) Select Field 3) Build Fields in Report 4) Column Settings
18 Tesues Tables Field Name Field Name Field:
Employes Groups Employee Employee Guardian ID -
1-9 Date Created e
E-Verify First Name Format:
Locations Middle Name Align:
Businass Unit Last Name
Login Other Names Used

Employee Name

Employee Phone Number

Reports: Interactive [Mine] Title
Date of Birth
Sodial Security Number -
Name Created by y y
~
Drag selected field to report Drag within list to change order
Employee Report Moreno, Denise
Interactive (10037) Morenao, Denise Refresh Field List Remove Field(s)
Interactive (10154) Moreno, Denise
Timeliness Report Moreno, Denise

Update Settings




Once selected, drag-and-drop

Intequfive Reports the selected item into the

3) Build Fields in Report section.

Guardian

Dashboard Start -9 Employee » E-Verify

Report Types ~ Settings Columns Preview
All Types -
e Tables & Fields
Interactive
Pending Reverifications 1) Select Table 2) Select Field 3) Build Fields in Report 4) Column Settings
-9 Issues =
Tables Field Name Field Name Field:
Employee Groups h d -
Employee Other Names Use Employee Name .
o Data Type:
19 ployee Name
E-Verify Employee Phone Number Format:
| ) 2) Select Field 3) Build Fields in Report
Locations Title Align
Business Unit Zef2 G BT Field Name Field Name
Login Secial Security Number Date Created Employee Name
Date Hired
First Name
Date Terminated Middle N
iddle Name
Reports: Interactive [Mine] SEE Last Name
Location
. . Other Names Used
Business Unit -
Name Created by = ; Employee Phone Number
Title
> Date of Birth
Drag selected field to report Drag within list to change order )
Social Security Number
Employee Report Moreno, Denise Date Hired
Interactive (10037) Moreno, Denise Refresh Field List Re e Field(s) Date Terminated
Interactive (10154) Moreno, Denise b D
Timeliness Report Moreno, Denise
Update Settings Drag selected field to report Drag within list to change order
Refresh Field List Remove Field(s)
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ltem order can be customized by
using a vertical “drag-and-drop”

Interactive Reporis

action to drag items within list to
change the order in the

Guardian

Dashboard Start1-9 Employee »
Report Types ~ Settings
Al Types Tables & Fields
Interactive

1) Select Table

Pending Reverifications

I-9 Issues
Tables
Employee Groups
Employee
I-9
E-Verify
Locations

Business Unit

Login
Reports: Interactive [Mine]
D Fier ~ x\ Refresh " Report v [ New

Name Created by
v

Employee Report Morena, Denise
Interactive (10037) Moreno, Denise
Interactive (10154) Moreno, Denise
Timeliness Report Morenao, Denise

Update Settings

E-Verify

Preview

2) Select Field

Field Name
Employee Guardian ID
Date Created
First Name
Middle Name
Last Name
Other Names Used
Employse Name
Title
Date of Birth
Sodial Security Number

Date Hired

Drag selected field to report

Refresh Field List

3) Build Fields in Report

Field Name
Employee Name
Date of Birth
Location Name
Business Unit Name
1-9 Date Created

Drag within list to change order

Remove Field(s)

3) Build Fields in Report section.

4) Column Settings

Field: Employee Name

Data Type: varchar

3) Build Fields in Report

Field Name

Location Name|

Employee Name
Date of Birth
Location Name
Business Unit Name

I-9 Date Created

Field Name
Location Name
Employee Name
Date of Birth
Business Unit Name

I-9 Date Created
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To remove a field from the report,

Interactive Reporis

select it in Step 3 and click the
Remove Field(s) button.

Guardian

Dashboard Start1-9 Employee «» E-Verify

Report Types ~ Settings Columns Preview
All Types -
P Tables & Fields
Interactive
Pending Reverifications 1) Select Table 2) Select Field 3) Build Fields in Report 4) Column Settings
b8 Tesues Tabl Field N Field N
ables ield Name ield Name s ald-
Employee Groups Field: Employee Name
Employee Employee Guardian ID Employee Name
Lo pioy e Data Type: varchar
-9 Date Created Date of Birth
E-Verify First Name Location Name Format: St”ng
Locations Middle Name Business Unit Name 5
Align: left ¥
Business Unit Last Name 1-9 Date Created
Login Other Names Used
Employse Name
Title
Reports: Interactive [Mine] Date of Birth
[ report + [ New Sodial Security Number
Date Hired -
Name Created by s y
v
Drag selected field to report Drag within list to change order
Employee Report Moreno, Denise
Interactive (10037) e e—— Refresh Field List Remove Field(s)
Interactive (10154) Moreng, Denise
Timeliness Report Morenao, Denise

Update Settings
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Interactive Reporis

Guardian

Dashboard Start1-9 Employee »
Report Types ~ Settings
Al Types Tables & Fields
Interactive

1) Select Table

Pending Reverifications

I-9 Issues
Tables

Employee Groups

Employee
I-9
E-Verify
Locations

Business Unit

Login
Reports: Interactive [Mine]
D Fier ~ x.‘ Refresh " Report v [ New

Name Created by
v

Employee Report Morena, Denise
Interactive (10037) Moreno, Denise
Interactive (10154) Moreno, Denise
Timeliness Report Morenao, Denise

Update Settings

Columns

E-Verify

Preview

2) Select Field

Field Name
Employee Guardian ID
Date Created
First Name
Middle Name
Last Name
Other Names Used
Employse Name
Title
Date of Birth
Sodial Security Number

Date Hired

Drag selected field to report

Refresh Field List

3) Build Fields in Report

Field Name
Employee Name
Date of Birth
Location Name
Business Unit Name
1-9 Date Created

13

Remove Field(s)

»

Drag within list to change order

The 4) Column Settings area allows

users to customize columns for

specific Data Types: Variable
Character, Integer, Standard Date,
Timestamp and Boolean.

4) Column Settings

Field: Employee Name
Data Type: varchar

Format: string

Align: left v
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The Variable Character Data Type
(for example, with Employee Name

Interactive Reporis

selected) allows the user to choose
the field format and to customize

Guardian

Dashboard Start1-9 Employee « E-Verify .I.he repor.l.is CO|Umﬂ Ollgnmen_l_
Report Types -~ Settings Preview
Al Tyes Tables & Fields
Interactive

1) Select Table

Pending Reverifications
-9 Issues
Tables

Employee Groups

Employee

-9

E-Verify

Locations

Business Unit

Login

Reports: Interactive [Mine]

N Fiter ~ x\' Refresh " Report New

MName Created by

Employee Report Moreno, Denise
Interactive (10037)
Interactive (10154)

Timeliness Report

Moreno, Denise
Moreno, Denise

Moreno, Denise

Update Settings

2) Select Field

Field Name
Employee Guardian 1D
Date Created
First Name
Middle Name
Last Name
Other Names Used
Employse Name
Title
Date of Birth
Social Security Number
Date Hired

Drag selected field to report

Refresh Field List

3) Build Fields in Report

Field Name
Employee Name
Date of Birth
Location Mame
Business Unit Name

1-9 Date Created

3 3

Drag within list to change order

Remove Field(s)

4) Column Settings

Field: Employee Name
Data Type: varchar

Format: string

Align: left

center
right
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Interactive Reporis

Guardian

Dashboard Start1-9

Report Types

All Types

Interactive

Pending Reverifications
I-9 Issues

Employee Groups

Reports: Interactive [Mine]

W Fiter v ¥ Re [ Report v [ New

Name Created by
Employee Report Morena, Denise
Interactive (10037) Moreno, Denise
Interactive (10154) Moreno, Denise
Timeliness Report Morenao, Denise

Fmplovee - Eiuerifv

Settings Columns Preview

Tables & Fields

1) Select Table 2) Select Field 3) Build Fields in Report
Tables Field Name Field Name
Employee Purge Eligibility Date ~ | Employee Name
19 Do Not Purge Date of Birth
E-Verify Language Location Name

Has HSPD-12 Exemption Business Unib Hame

Has Top Secret Clearance 1-9 Date Created

Locations
Business Unit

Provides Support Services Only

Login Employee Group

Is On Leave

Emp Employee Exemption
Emp Employee Designation
Notification E-Mail 1
Notification E-Mail 2

Drag selected field to report Drag within list to change order

Refresh Field List Remove Field(s)

Update Settings

The Integer Data Type (for example,
with Employee Group selected)

allows for editing of the field format
and to customize the report’s
column alignment.

4) Column Settings

Field: Employee Group

Data Type: integer

Format: None v

. Padded Zeros

Align: Comma Separated Padded Zeros
Comma Separated
Roman Numerals

Example 10965

Mone 10965

Padded Zeros 000000010965

Comma Separated Padded 000.000.010.965

Zeros

Comma Separated 10,965

Roman Numerals Too Bigl (10 = X)
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. The Boolean Data Type (for

Interactive Reporis example, with Do Not Purge

: selected) has various format
Guardian choices available.

Dashboard Start1-9 Employee «» E-Verify

Report Types ~ Settings Columns Preview
All Types -
P Tables & Fields
Interactive
Pending Reverifications 1) Select Table 2) Select Field 3) Build Fields in Report 4) Column Settings
[-9 Issues . .
ol Tables Field Name Field Name Field: Do Not Purge
ployee Groups Employee ID |
Employee - Employee Name
- Data Type: boolean
19 Purge Eligibility Date Date of Birth
E-Verify Language Location Name Format: Yes/No ~
Locations HEE AEADAE (EE i Business Unit Name
Business Unit Has Top Secret Clearance I Date Created _ True/False
Login Provides Support Services Only Employee Group Align: 1/0
Is On Leave Do Not Purge X
Emp Employee Exemption
Reports: Interactive [Mine] Emp Employee Designation e
N p xample True
Notification E-Mail 1 .
“ report + [ New Yes/No Yes
Notification E-Mail 2 True/False True
10 1
Name Created by b y X M
v
Drag selected field to report Drag within list to change order
Employee Report Morena, Denise
Interactive (10037) e e—— Refresh Field List Remove Field(s)
Interactive (10154) Moreno, Denise
Timeliness Report Morenao, Denise
Update Settings
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The Date Data Type (for example,

Intequflve Reports with Date Hired selected) offers

various date field formarts.

Guardian

Dashboard Start1-9 Employee «» E-Verify

Report Types ~ Settings Columns Preview
All Types -
P Tables & Fields
Interactive
Pending Reverifications 1) Select Table 2) Select Field 3) Build Fields in Report 4) Column Settings
b8 Tesues Tabl Field N Field N
ables ield Name ield Name Field: i
Employee Groups Employee Last Name | Employee Name Bate Hired
Data Type: date
% Other Names Used i O
E-Verify Employee Name Location Name Format: Standard v
Locations T 5 2 AR (G Business Unit Mame Short
Business Unit Title 1-9 Date Created . Standard
G Date of Birth T S Align: International Short
Sodial Security Number Do Not Purge Interna?lonal Standard
Date Terminated — Example Abbreviated
[ ] E-Mail Short Long
Reports: Interactive [Mine’ Standard Day Lon
L ==IEn International Sho| C v t a
Business Unit International Sta omputer
e T < Abbreviated Feb 28, 2011
D1eE ey > » | Long February 28, 2011
Day Long Monday. February 28, 2011
v Computer 2011-02-28
Drag selected field to report Drag within list to change order
Employee Report Morena, Denise - -
Interactive (10037) e e—— Refresh Field List Remove Field(s)
Interactive (10154) Moreno, Denise
Timeliness Report Morenao, Denise

Update Settings
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o The Timestamp Data Type (for
Intequhve Reports example, with Date Created

selected) offers various date & fime
field formats.

Guardian

Dashboard Start -9 Employee E-Verify

Report Types ~ Settings Columns Preview
All Types -
P Tables & Fields
Interactive
Pending Reverifications 1) Select Table 2) Select Field 3) Build Fields in Report 4) Column Settings
18 fesues Tabl Field N Field N
ables ield Name ield Name <ol -
Employee Groups Field: Date Created
Employee Employee Guardian 1D Employee Name .
ploy ploy ploy Data Type: timestamp
I-9 First Name Date of Birth
E-Verify Middle Mame Location Name Format: Short AM/PM v
Locations Last Name Business Unit Name Short AM/PM
Business Unit Other Names Used 1-9 Date Created ) Short 24 Hour
Login Employee Name Employee Group G Short w/o time
Employee Phone Number Do Mot Purge mtemat!onal Short AM/PM
p— — \nternat!onal Short 24 Hour
) 5 Date of irth ey — Examp‘éf International Short w/o time
Reports: Interactive [Mine] ate of Bi ate Create Short AMIPM Standard AM/PM
Social Security Number Short 24 Hour
- EL N + EN Short wio time Standard 24 Hour
Date Terminated - International Sho| Standard w/o time
Mame Created by International Sho| - "
» » AP
International Sha \ntemat!onal Standard AM/PM
v Standard AM/PM| International Standard 24 Hour
Drag selected field to report Drag within list to change order g:::g::g ?doHlﬁ_; International Standard w/o time
o Computer
;i International Sta
Empl Report M D '
i o rERD, DEe Refresh Field List Remove Field(s) International Star Computer wia time
Interactive (10037) Mareno, Denise International Star. Abbreviated w/o time
N - Computer ,
Interactive (10154) Moreno, Denise Computer w/o fin Long w/o time ]
Timeliness Report Mareno, Denise Abbraviated wio Day Long w/o time
Long wio time February 28, 2011
Day Long wio time Monday, February 28, 2011
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Guardian

Dashboard

Report Types

All Types

Interactive

Pending Reverifications
[-9 Issues

Employee Groups

Reports: All Types [Mine]
W Fiter v ™ Refresh @B Report ~ . ey

Interactive Reporis

Start 1-9

~ Settings

Employee » E-Verify

Columns Preview

Tables & Fields

1) Select Table 2) Select Field

Tables Field Name
Employee

19

E-Verify

Locations

Business Unit

Login

Name

Employee Report

Interactive (10037)

Interactive (10154)

Pending Reverifications (10096)
Pending Reverifications {10155)
Pending Reverifications (10156)

Timeliness Report

Created by

Moreno,
Mareno,
Moreno,
Moreno,
Moreno,
Mareno,

Moreno,

Denise
Denise
Denise
Denise
Denise
Denise

Denise

Drag selected field to report

ield

Update Settings

3) Build Fields in Report

Field Name
Location Name
Employse Name
Date of Birth
Business Unit Name
1-9 Date Created

L]

Drag within list to change order

Remove Field(s

Once the desired items have
been moved into the 3) Build Fields
in Report section, click the
Update Settings button.

The Preview tab will open and an
automatic preview will appear.

4) Column Settings

Field:
Data Type:
Format:

Align:
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|n‘|'erq C'l'ive Reporfs The Preview tab shows a preview of

the report in a data grid, based on
Column and Settings tab selections.
The preview will appear with up to the

Guardian

Dashboard Start 1-9 Employee - E-Verify .
first T00 rows of data.
S " ow o Crequire th
A Types T — —— —-— ( € preview adoes NoT require thne user
Interactive Location N; Empl N Busi Unit N 1-9 Date Created 1
ocation Name ! mployee Name usiness Unit Name -9 Date Create 'I' f 'I' 'I'h 'I'
Pending Reverifications O |rS rU n e re Or .
Austin Johnson, Brenda Central US 08/20/20 @ 04:42 PM
I8 Issues Austin Stevens, Stephanie Central US 00/08/20 @ 10:18 AM
Employee Groups Cleveland McNeil, Nancy Eastern US 08/25/20 @ 02:22 PM
Cleveland Smith, Marge Eastern US 08/25/20 @ 02:31 PM
DM Import Smith, Jeshua Eastern US 08/18/20 @ 10:22 AM . .
DM Import Price, Rafael Eastern US 08/18/20 @ 10:32 AM R ‘I'h |‘I' d f d d
DM Import Shaw, Jane Eastern US 08/18/20 @ 10:32 AM eVIeW e reSU S ! O n | n ee e
DM Import Bailey, Tony Eastern US 08/18/20 @ 10:33 AM |< d M .I. .I. .I. .I.h F'", .I.'
DM Import Sanchez, Richard Eastern US 08/18/20 @ 10:33 AM | I I e O J US | I . n S O e I er o p |O nS
DM Import Rice, Denise Eastern US 08/18/20 @ 10:33 AM .
and Column selections. If any
Reports: All Types [Mine] DM Import Drake, Emma Eastern US 08/18/20 @ 10:33 AM
DM Import Freeman, Monica Eastern US 08/18/20 @ 10:33 AM
Py e — : ‘ hang re made, th rmay
iter = & Refresh WP Report ~ [ e DM Import Clark, Kevin Eastern US 08/18/20 @ 10:33 AM C O es O e O e’ e Use O
Mame Created by DM Import Malone, Chris Eastern US 08/18/20 @ 10:33 AM .I. .I. .I.h P - .I. b d |‘ |<
DM Import Ward, Amanda Eastern US 08/18/20 @ 10:33 AM re U rn O e rev' ew O O n C IC
h DM Import ‘Young, Colleen Eastern US 08/18/20 @ 10:33 AM .
ot oot Eatam el Refresh to review updated resulfs.
Employee Report Moreno, Denise DM Impaort Andrews, Leon Eastern US 08/18/20 @ 10:33 AM
Interactive (10037) Moreno, Denise DM Import Marsh, Poula Eastern US 08/18/20 @ 10:33 AM
Interactive (10154) Moreno, Denise DM Import Jacksen, Joe Eastern US 08/18/20 @ 10:33 AM
Pending Reverifications (10086) Moreno, Denise DM Import Reed, John Eastern US 08/18/20 @ 10:34 AM
Pending Reverifications (10155) Moreno, Denise DM Import Lee, Joan Eastern US 08/18/20 @ 10:34 AM
18/ B
Pending Reverifications (10156) T — DM Import Barber, Alison Eastern US 08/18/20 @ 10:50 AM
E-Verify Cases Lawrence, Rebecca Central US 08/07/20 @ 04:53 PM
Timeliness Report Moreno, Denise
E-Verify Cases Jones, Douglas Central US 08/12/20 @ 10:33 AM
E-Verify Cases Jones, Martin Central US 08/13/20 @ 08:32 AM

E-Verify Cases MNess, Sabina Central US 08/13/20 @ 09:59 AM
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From the Settings tab, select the

|n'|'erC|CﬁV€ Reporis desired Filter Options.

G u ard ia n Announcements Help + Denise Moreno + Logout

Dashboard Start -9 Employee » E-Verify

Report Types ~ Settings Columns Preview
Al Types ter O ns &
Interactive
* Employee Group:
Pending Reverifications Py p-| My Managed Groups ’
[-9 Issues Employee Location: | All .
Employee Groups
Employee: | All v
Emp Employee Exemption: | All v
Emp Employee Designation: | Al v
1-8 Forms: | Al v
Scope: | All v
Reports: All Types [Mine]
19 Error Type: | All .
Name Created by E-Verify Status: | Any M
o Initial TNC: | N/A -
FAR Batch: | N/A v
Employee Report Moreno, Denise
Interactive (10037) Moreno, Denise Business Unit: v
Interactive (10154) Moreno, Denise
Pending Reverifications (10096 Mareno, Denise
9 { ) Date Range
Pending Reverifications (10155) Moreno, Denise
Pending Reverifications {10156) Morena, Denise Date to Search: | None v RaluE e e Rl (PR SR
el -30 Last 30 days 60 Mext 60 days
Timeliness Report Moreno, Denise crom: m This Month _m Last Month
6m 6th Month
To: q This Quarter -q Last Quarter

2q Second Quarter
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|n'|'erqcﬁve Repori-s Set the Date Range and Sort Options

of the report, if desired.

Guardian
Dashboard Start 1-9 Employee » E-Verify Click Updqi‘e Seitings Ond Run Report
Report Types ~ Settings Columns Preview N ow.

I LW ype. | Ay

All Types
Interactive E-Verify Status Any v
Pending Reverifications
-0 Issues Initial TNC: | N/A v
Employee Groups
pey s FAR Batch: | N/A v
Business Unit: v

Date Range

Date to Search: | None Value Date Range Value Date Range
-30 Last 30 days 60 Mext 60 days
m This Month -m Last Month
From: Y
o 6m 6t
Reports: All Types [Mine] m ) on
To: q This Quarter -q Last Quarter
) 2q Second Quarter
This Year -y Last Year
Name Created by v g
Auto Calc:
®
~
Employee Report Moreno, Denise
Sort Options
Interactive (10037) Moreno, Denise
Interactive (10154) Mareno, Denise Primary Sort: | | ocation Name B

Pending Reverifications (10096) Moreno, Denise
Pending Reverifications (10155) Moreno, Denise Direction: | A-7 N
Pending Reverifications {10156) Morena, Denise

Timeliness Report Mareno, Denise * If the HR Filter Group is specified, it will be used instead of the Responsible HR Filter.

Update Settings Run Report Now

Copyright © 2023, Equifax Inc., Atlanta, Georgia. All rights reserved. Equifax and the Equifax marks used herein are

trademarks of Equifax Inc. Other product and company names mentioned herein are the property of their respective owners.




The screen will refresh every 15

Infequfive Reports seconds until the report has

. completed. Users may navigate
Guardian away from this screen while the

Dashboard Start1-9 Employee » E-Verify repor-l- processes.

Report Types #  Report Details & Settings

All Types Report Information

Interactive
Report Type: Interactive

Created by: Moreno, Denise : 09/22/2020 @ 13:22:51

Last Run:

Pending Reverifications
-9 Issues

Employee Groups )
Report is Scheduled

As of 14:58:45 MST, this report is #1 in the queue.
This page will automatically update every 15 seconds until the report is completed.

Check Repart

Reports: All Types [Mine]
D Fiter ~ x." Refresh " Report « . le

Name Created by
~
Employee Report Mareno, Denise
Interactive (10037) Moreno, Denise
Interactive (10154) Moreno, Denise

Pending Reverifications (10096} Moreno, Denise
Pending Reverifications {10155) Meoreno, Denise
Pending Reverifications (10156) Moreno, Denise

Timeliness Report Moreno, Denise
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Once complete, reports may be

InfequﬁVG Reporis viewed in the web browser or

downloaded as an Excel file.

Guardian

Dashboard Start -9 Employee » E-Verify

Report Types ~ Settings Columns Preview
All Types -

v Report Information
Interactive

Report Type: Interactive

-9 Issues Created by: Moreno, Denise : 09/22/2020 @ 13:22:51
Employee Groups LastRun: 09/22/2020 @ 14:58:48

Rows X Columns: 108 X 4

< View Report Download Excel Report >

Pending Reverifications

Report Settings
Report Name: | Employee Report ] 10158

Base Table: Fmployee

Reports: All Types [Mine]

Scheduler Options @

Name Created by Generate Automatically: | Monthly v
o Days To Run: | Every 1 Day of The Month v
Employee Report Moreno, Denise Filter Options
Interactive (10037) Moreno, Denise
» .
Interactive (10154) Moreno, Denise Employee Group: | My Managed Groups ht
Pending Reverifications (10096) Moreno, Denise Employes Lacation: | All g
Pending Reverifications (10155) Moreno, Denise
Pending Reverifications {10156) Morena, Denise Employee: | Al v
Timeliness Report Moreno, Denise
Emp Employee Exemption: | Al v
Emp Employee Designation: | Al v
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Report Module
Functions
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The Report button can be used to

REPOI‘f Module Fu nCﬁOHS Duplicate or Delete a report.

G u ard ia n Announcements Help + Denise Moreno + Logout

Dashboard Start -9 Employee » E-Verify

Report Types ~ Settings Columns Preview
All Types -

¥ Report Information
Interactive

Report Type: Interactive

-9 Issues Created by: Moreno, Denise : 09/22/2020 @ 13:22:51
Employee Groups LastRun: 09/22/2020 @ 14:58:48

Rows X Columns: 108 X 4

Pending Reverifications

View Report Download Excel Report

Report Settings
Report Name: | Employee Report ] 10158

Base Table: Fmployee

Reports: All Types [Mine]

Scheduler Options @

Duplicate Generate Automatically: | Monthly v
Delete
Days To Run: | Every 1 Day of The Month v
Employee Report Moreno, Denise Filter Options
Interactive (10037) Moreno, Denise
» .
Interactive (10154) Moreno, Denise Employee Group: | My Managed Groups h
Pending Reverifications (10096) Moreno, Denise Employes Lacation: | All Z
Pending Reverifications (10155) Moreno, Denise
Pending Reverifications {10156) Morena, Denise Employee: | Al v
Timeliness Report Moreno, Denise
Emp Employee Exemption: | Al v
Emp Employee Designation: | Al v
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Click on the Duplicate option to

REPOI'f Module Fu nCﬁOHS duplicate a report, saving time on

. recreating specific report settings. A
Guardian new report name can be assigned
Dashboard Start -9 Employee E-Verify 'I'O 'I'he newly Creg'l'ed repor'l'.

Report Types ~ Settings Columns Preview
All Types -

Z Report Information
Interactive

Report Type: Interactive
Created by: Moreno, Denise : 09/22/2020 @ 13:22:51
LastRun: 09/22/2020 @ 14:58:48
Rows X Columns: 108 X 4

Pending Reverifications
[-9 Issues

Employee Groups
View Report Download Excel Report
Report Settings

Report Name: | Employee Report 158

Base Table: Fmployee

Reports: All Types [Mine]
W Fiter v (\' Refresh “ Report = . ey

Duplicate

Scheduler Options @

Generate Automatically: | Monthly

Delete

Days To Run: | Every 1 Day of The Month

Employee Report Moreno, Denise Filter Options

Interactive (10037) Moreno, Denise

Interactive (10154) Moreno, Denise * Employee Group: | My Managed Groups
Pending Reverifications (10096) Moreno, Denise Employes Lacation: | All
Pending Reverifications (10155) Moreno, Denise

Pending Reverifications {10156) Morena, Denise Employee: | Al

Timeliness Report Moreno, Denise
Emp Employee Exemption: | Al

Emp Employee Designation: | Al

Copyright © 2023, Equifax Inc., Atlanta, Georgia. All rights reserved. Equifax and the Equifax marks used herein are

trademarks of Equifax Inc. Other product and company names mentioned herein are the property of their respective owners.



Click on the Delete option to delete

Report Module Functions areport

G u ard ia n Announcements Help + Denise Moreno + Logout

Dashboard Start -9 Employee » E-Verify

Report Types ~ Settings Columns Preview
All Types -

¥ Report Information
Interactive

Report Type: Interactive

-9 Issues Created by: Moreno, Denise : 09/22/2020 @ 13:22:51
Employee Groups LastRun: 09/22/2020 @ 14:58:48

Rows X Columns: 108 X 4

Pending Reverifications

View Report Download Excel Report

Report Settings
Report Name: | Employee Report ] 10158

Base Table: Fmployee

Reports: All Types [Mine]

Scheduler Options @

Generate Automatically: | Monthly v
Delete
Days To Run: | Every 1 Day of The Month v
Employee Report Moreno, Denise Filter Options
Interactive (10037) Moreno, Denise
» .
Interactive (10154) Moreno, Denise Employee Group: | My Managed Groups h
Pending Reverifications (10096) Moreno, Denise Employes Lacation: | All Z
Pending Reverifications (10155) Moreno, Denise
Pending Reverifications {10156) Morena, Denise Employee: | Al v
Timeliness Report Moreno, Denise
Emp Employee Exemption: | Al v
Emp Employee Designation: | Al v
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o A Warning will appear confirming
Report Module Functions report deletion as permanent. User

may cancel the process by clicking

Guardian Cancel, or continue with deleting
Dashboard Start -5 Employee + E-verfy the report by clicking Delete Report.

Settings Columns

Report Types ~ Warning!

All Type -
L Report Information

Interactive

Pendin

You Are About to
Permanently Delete Report

"Employee Report"!

Report Settings Please be advised that if you continue, the current report will be
permanently deleted from the system!

Delete Reportl

Reports: All Types [Mine]

Scheduler Options @
ﬂ Filter = e Refresh . Report = . New

Generate Automatically

Name Created by

Days To Run

Employee Report Moreno, Denise Filter Options

* Employee Group: | My Managed Groups

Employee Location | A

Employes: | A

Timeliness Report
Emp Employee Exemption: | A

Emp Employee Designation: | A
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Large Reports
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Large Reports

Large reports are reports that have generated over 2,999 cells of
information in any given report. These types of reports are too large to view
onscreen in the standard HTML format that is normally accessed by clicking
the View Report link (which will not be available to access onscreen).

Instead, the user will see the Download Report link only, with an alert
indicating that the report must be downloaded to the user’s local system.
This can be accomplished by clicking the Download Report link.
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. A notification appears confirming
DOWh|OCIdIng the Repori that the report size exceeds 2,999

cells of information and will require

Lawlogx system downloading to view.

Jashesrd s Employee v =i User may continue the process by
ReportTypes A el e clicking the Download Report link.

All Types

Report Information
Interactive
Report Type: Interactive

Created by: Reaume, Robert : 02/14/2017 @ 10:47:00
LastRun: 03/14/2017 @ 10:42:33
Rows X Columns: 521 X 50

Download Report

This report is too large to view onscreen (over 9999 cells), and must be downloaded to your local computer.

Pending Reverifications
[-9 Issues

Employee Groups

Right-Click the link above and select the download option from the popup menu.

Reports: All Types [All]
W Fiter ~ ¥ Refresh “ Report « . ey

Report Settings

Mame Created by
big . Report Name:  Big Report [}] 6242
Base Table: 1O
Big Report Reaume, Robert

Scheduler Options @
Generate Automatically:

Days To Run: v Must first select frequency above to set how often the report will be generated

Filter Options
* Employse Group: | My Managed Groups
Employee Location: | All

Employee: | All
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Down'Oading the Repor.l. The report will be exported fo a

Zip file, appearing in the lower left
corner of the screen to access.

Lawlogix .
= Upon clicking the caret symbol, the
Dashboard Start -9 Employee v E-Verify Op-l-lons W”l O”OW .I.O .I.he flle .I.O be
Repot Trye I R R opened or viewed from the
Al Typeé Report Information

Pending Reverifications Report Type: Interactive d OWn | O O d fo | d e r.

I-9 Issues Created by: Reaume, Robert : 02/14/2017 @ 10:47:00 H .
Employee Groups LastRun: 03/14/2017 @ 10:42:33 (Thls process moy vGry dependlng

R on the type of system being used).

This report is too large to view onscreen (over 9999 cells), and must be downloaded to your local computer.

Right-Click the link above and select the download option from the popup menu.

Reports: All Types [All]
M Fitter v -C' Refresh ’ Report v .

Report Settings

Name Created by
big S Report Name:  Big Report [f] 6242
Base Table: 19
Big Report Reaume, Robert

Scheduler Options @

Generate Automatically
Days To Run - v Must first select frequency above to set how often the report will be generated

Show in folder

Ope

Always open files of this type L Options
‘ * Employee Group: | My Managed Groups
|
|

Show all X
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o Clicking the Show in Folder opftion
DOWI'\'OCIdlng ihe Report will allow the user to see the zipped

file. Proceed to unzip the file by
right clicking on the file.

Irngogix

Dashboard Start I-9 Employee » E-Verify

Report Types ~ Settings Columns Preview
All Types "

L Report Information
Interactive

Report Type: Interactive
Created by: Reaume, Robert : 02/14/2017 @ 10:47:00
LastRun: 03/14/2017 @ 10:42:33
Rows X Columns: 521 X 50
Download Report

Pending Reverifications
I-9 Issues

Employee Groups

This report is too large to view onscreen (over 9999 cells), and must be downloaded to your local computer.

Right-Click the link above and select the download option from the popup menu.

Reports: All Types [All]
N Filter v

Report Settings

Name Created by
big U Report Name: ' Big Report [f] 6242
Base Table: 19
Big Report Reaume, Robert
Scheduler Options @
Generate Automatically - Select Frequency -- v
Days To Run: Select Days To R v Must first select frequency above to set how often the report will be generated
Qpen
Always open files of this type tions
Show in folder * Employee Group: | My Managed Groups v
Cancel
Show all X

BigRepo! ~
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o . o Right click on the Zipped file folder
UT\Z|PP|n9 Illhe Report flle and right click on the Extract All

item in the navigation bar.

Open

oren The Extract Menu will appear. Begin
"E”'”"E"‘”’"'"r the unzip process by clicking the

Extract All...

7-Zip > Browse button.

CRC SHA )
Pin to Start

Scan for threats

Extract Compressed (Zipped) Folders

| [=

Share

Open with... L. .
Select a Destination and Extract Files

.| ShareBase >
Files will be extracted to this folder:

Give access to > C:\Users\Dmoreno\Downleads\BigReport Browse...

Restore previous versions

Show extracted files when complete
Send to .

Cut
Copy

Create shortcut
Delete

Rename

Properties
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Select the desired destination of

Unzipping the Report file the file.

E | Select a destination ) ' >
A |§| » This PC » Documents v 0 Search Documents 2
Organize - Mew folder == - 9
[ This PC Al MName Date
) 30 Objects Zoom 3/16/2020 10:19 AM
[ Desktop Camtasia 3/3/2020 11:31 AM
2 Documents original 2/20/2020 11:37 AM
Custom Office Templates 2/20/2020 817 AM
‘- Downloads
. 2/19/2020 3:44 PM
J‘& Music
=| Pictures
B videos
e Windows ()
LB 4 >
Folder: | |
Select Folder Cancel
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Open a New Excel Spreadsheet

Importing the Report to Excel and click on the Data Tab.

-

Insert Page Layout Farmulas Data Review View Acrobat ¢ Tell me what you want to da...
s Y - =
D b Cut Calibri 11 A A T== - EWapTxt General - -'-| E.‘ Normal
By Copy -
Paste _ B I U~ ¥« M. +r = = = ¥= 3= EMEF e & Center = $ - 0 3 &0 00 Conditional Format as
- ¥ Format Painter a o = - ? o Formatting - Table~ I:
Clipboard Fa Font T Alignment Fa Mumber M
Al - §
A E | C | D | E | E . G | H | | J | K | L . M | M | C
1 |
| | |
2 B
3 B
4_
5 B
6_
?_
8_
g_
10

Copyright © 2023, Equifax Inc., Atlanta, Georgia. All rights reserved. Equifax and the Equifax marks used herein are

trademarks of Equifax Inc. Other product and company names mentioned herein are the property of their respective owners.



Once the Data Tab is selected, click

Importing the Report to Excel on the From Text icon.

-

Hame Insert Page Layout Formulas Review View Acrobat ¢ Tell me what you want to do...

D FD Dﬂhnwﬂueries @ Lzl Connections g'l Y Clear E’E E‘ E-}g

— DFrDmTaI:IIE Properties ] Reapply
From From| From JFrom Other Existing Mew Refresh R '%'l Sort Filter Textto Flash  Remowe
Access Web Sources~  Connections  CQuery - [% Recent Sources All - Edit Links Yo Advanced | columns  Fill Duplicates
Get External Data Get & Transform Connections Sort & Filter

Al - Fx

A B . C . D . E . F . G . H . . ] . K . L . [ . M . 9
1 !
2_
3_
4_
5_
5_
?_
8_
9_
10
11
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On the Import Text File menu, select

|mp0rﬁng the Reporf to Excel the unzipped report file and click

the Import button.

= Book]l
Home Insert Page Layout Formulas [ Q Tell me what you want to do...
[T PSS ws T o = (=1~ e — oy W~ s =
Eé I:% [E mport Tesxt File ey Eéa
Frorn From From Fro Flash Remowve
Access Web Text 5d € v A » ThisPC » Downloads » BigReport (1) w | () Search BigReport (1) 2 E Fill  Duplicates
Get BExtern
Organize « Mew folder ==~ 1 @

Al N ; Downloads o+ Mame Date modified

A | B | Pictures ol | RPT_R6242 , 9/23/202011:33AM || N | ©
1 [ ShareBase -
2 | 2020 EV-Menu Guardian Tuterial Project
3 | Backgrounds
4
s i Client medified sessions
6 | GU

] v £ >

? -
g File name: |RPT_RA242 ~ | | Text Files w
9

T Tools - Cancel
10
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Importing the Report to Excel

-

On the Import Text File menu, select
the unzipped report file and click
the Import button.

Book1
Home Insert Page Layout Formulas Acrobat Q@ Tell me what you want to do...
Y Y p— | e 1Y = — [ o~ I L ' P =
® 2[5 [@eoren <5 BB
Frorn From  From Fro Flash Remowve
Access Web  Text 5d € v A » ThisPC » Downloads » BigReport (1) w | () Search BigReport (1) 2 E  Fill  Duplicates
Get BExtern
Organize « Mew folder ==~ 1 @
Al N ; Downloads o+ Mame Date modified
A B | Pictures ol | RPT_R6242 , 9/23/202011:33AaM || N | ©
1 [ ShareBase -
2 | 2020 EV-Menu Guardian Tuterial Project
3 | Backgrounds
4
s i Client medified sessions
6 | GU
] v £ >
? -
g File name: |RPT_RA242 ~ | | Text Files w
9 j
] Tools - Import Cancel
10|
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o On Step 1 of 3 of the Text Import
|mp0rflng 'I'he RGPOﬂ 'l'O EXCQI Wizard, click the Next button.

Home Insert Page Layout Farmulas View Acrobat W Tell mew
. — o1 l — Clear ~N =
@ i |:| Text Import Wizard - Step 1 of 3 7 X AlzZ EE *
= Reappl
From From  Frormn  Fro The Text Wizard has determined that your data is Delimited. l Sort Filter ' Textto Flash Remove
Access  Web Text 5q If this is correct, choose Mext, or choose the data type that best describes your data. !"Advancelj Columns Fill DI.IFI“CEtES
Get Exterr| Original data type Sort & Filter
Choose the file type that best describes your data:
Al - @ - Characters such as commas or tabs separate each field.
O Fixed width - Fields are aligned in columns with spaces between each field.
A B ] K L Pl M C
1 I Start import at row: |1 = | File arigin: 437 : OEM United States ~
! | ]
2
3 1 [ My data has headers.
4 i Preview of file C:\Users\Dmoreno'\Downloads\BigReport [1\RPT_RB242 tut.
3
1 1l ["Guardian Company™ a
& "Big Beport™
N 3 "
7 | 'Tuesday, March 14, 2017"
2 W
g
10 Cancel FEinish
11
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Importing the Report to Excel

Home

® 3L

Fram From @ From Fro

Insert

Page Layout Farmulas

{— {—

View

Acrobat

On Step 2 of 3 of the Text Import
Wizard, click the Next button.

::;:: Tell me what yo

Access Web | Text | 54
Get Exterry
Al -
A B
1 !
2_
3_
4_
5-
5_
?_
8_
9-
10
11

Text Import Wizard - Step 2 of 3

This screen lets you set the delimiters your data contains, You can see how your text is affected in the

preview below.,

Delimiters

b4 1ab

|:| Semicolon
Dgomma
[ space

[] other:

|:| Treat consecutive delimiters as one

Text gualifier: |~ ~

Data preview

nardian Company
ig Beport

uesday, March 14, 2017

Cancel

< Back

Finish

Clear

Y

Reappl
l Sort Filter e
!p‘ﬁkdxranced
Sort & Filter
] K L

Em 2 BE

Text to
Colurmns

Flash
Fill

Remove
Duplicates
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Importing the Report to Excel

Home

® 3L

Fram From @ From Fro

Insert

Page Layout Farmulas

{— {—

View

Acrobat

On Step 2 of 3 of the Text Import
Wizard, click the Next button.

::;:: Tell me what yo

Access Web | Text | 54
Get Exterry
Al -
A B
1 !
2_
3_
4_
5-
5_
?_
8_
9-
10
11

Text Import Wizard - Step 2 of 3

This screen lets you set the delimiters your data contains, You can see how your text is affected in the

preview below.,

Delimiters

b4 1ab

|:| Semicolon
Dgomma
[ space

[] other:

|:| Treat consecutive delimiters as one

Text gualifier: |~ ~

Data preview

nardian Company
ig Beport

uesday, March 14, 2017

Cancel

< Back

Finish

Clear

Y

Reappl
l Sort Filter e
!p‘ﬁkdxranced
Sort & Filter
] K L

Em 2 BE

Text to
Colurmns

Flash
Fill

Remove
Duplicates
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o On Step 3 of 3 of the Text Import
|mp0rf|ng the Report II'O EXCQI Wizard, click the Finish button.

Home Insert Page Layout Farmulas View Acrobat Y Tell me what yo
— — — sz Y = . = =1 - —
Iy 51 '51 — Y Clear ~¥
@ & |:| Text Import Wizard - Step 3 of 3 ? X l . | EE = =
= . WEdpply
From From = From  Frd This screen lets you select each column and set the Data Format, l Sort Filter Y, Textto Flash Remowve
Access Web | Text 5S¢ Column dataformat # Advanced  Columns  Fill  Duplicates
General & Fi
Get Eifedy @ - ‘General’ converts numeric values to numbers, date values to dates, and S0 L
OIE’“: all remaining values to text.
Al e O Date: | MDY ~ Advanced...
Cl Do not import column (skip)
A B ] K L Pl M C
1 |
I ]
2
3
Data preview
4
3
i)
7 4, 2017
)
g
10 Cancel < Back
11

Copyright © 2023, Equifax Inc., Atlanta, Georgia. All rights reserved. Equifax and the Equifax marks used herein are

trademarks of Equifax Inc. Other product and company names mentioned herein are the property of their respective owners.



o On Step 3 of 3 of the Text Import
|mp0rflng 'I'he RGPOﬂ 'l'O EXCQI Wizard, click the Finish button.

Home Insert Page Layout Farmulas View Acrobat ¢ Tell me what you want to do...
P D D i i -_ =0 == IIZ 2] Connections ,.:.,l Y Clear E@ = E_}g
@ = = Import Data ? X = . Zv |alz =2 I:
Properties ] Reapply
From From | From Frg ) ) ) Refresh - '%'l Sort Filter Textto Flash  Remowe
Access Web | Text Sd SEIeéhnw:_nslwanttn view this data in your workboaok, All = Edit Links !p‘ﬁkdxranced Columns  Fill Duplicates
able
Get Exterry Connections Sort & Filter
PivotTable Report
Al - I PivotChart
[‘ COnly Create Connection
A E Where do you want to put the data? . H . . ] . K . L . M . M . C
1 | (®) Existing worksheet:
| | |

2 | =5451| Fis:

2 () Mew worksheet

4 | |:| Add this data to the Data Model

5

6 | Froperties... Cancel

? -

8 -

9 e
10
11
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Importing the Report to Excel

Insert Page Layout

Formulas Data View

Book1 - Excel

Acrobat ‘-;: Tell me what ye

The report data will auto-fill the
fields in the Excel sheet.

= - x

Denise Moreno £, Share

b Cut Calibri -l £ == ®- SWeptex General £L4 | Normal Bad Goad Neutral fm EX E X Autosum - Aqy p
Past E@Copy ’ = 3= €0 o0 Conditi | Fi ﬂt Expl it - IEEIrt IEE\‘et Fe it mF\H' SZFt&F d &
%€ Format Painter Iu- < =32 EMegetiCenter - § - % > 9 M Foor:qa‘tt‘lon";- ?r;n;;vas @ Explanatory ... |Input Linked Ce Note b=t Bdsmbanet o Fﬁter' S;?ectv
Clipboard [F1 Font ] Alignment [F] Humber [F1 Styles Cells Editing ~
M10 - £ U.S. Citizen L7
A B © D E F G H J K L -
1 |Guardian Company
2 |Big Report
a
4 |Tuesday, September 22, 2020
5
6 |I-9 Status 19 Type I-9 Imported Type 1-9 Number S2 List A Document #1 S2 List A Document Uploaded S2 Document A Name S2 List A Authority S2List A Document S1 Date Employee Hired 51 Date Signed S1Date First Signed = S1Ci
7 |Approved Electronic I-9 N/A 1705680 Na 0 2/2/2016 07/15/15 @ 03:44 PM  07/15/15 @ 03:44 PM
8 |Approved Electronic I-9 N/A 1733034 12456745 Yes U.S. Passport or Passport Card Department of State 37 3/17/2016 08/17/15 @ 12:02 PM  08/17/15 @ 12:02 PM
9 |Approved Electronic I-9 N/A 1742293 236578923 Yes U.S. Passport or Passport Card Department of State 37 9/29/2015 09/25/15 @ 10:18 AM 09/25/15 @ 10:18 AM
10 |Approved Electronic I-9 N/A 1742302 2356387 Yes U.S. Passport or Passport Card Department of State 37 9/25/2015 09/25/15 @ 01:07 PM  09/25/15 @ 12:57 PM |
11 |Approved Electronic I-9 N/A 1742304 45768793 Yes U.S. Passport or Passport Card Department of State 37 9/25/2015 09/25/15 @ 01:28 PM  09/25/15 @ 01:28 PM
12 |Approved Electronic -9 N/A 1742309 235647 Yes U.S. Passport or Passport Card Department of State 37 9/30/2015 09/28/15 @ 11:20 AM 09/28/15 @ 11:20 AM
13 |Approved Electronic -9 N/A 1743635 23548769 Yes U.S. Passport or Passport Card Department of State 37 9/29/2015 09/29/15 @ 11:59 AM 09/29/15 @ 11:59 AM
14 |Approved Electranic I-9 N/A 1744406 245787 Yes U.S. Passport or Passport Card Department of State 37 9/29/2015 09/29/15 @ 01:18 PM  09/29/15 @ 01:18 PM
15 |Approved Electronic I-9 N/A 1744715 No 0 10/9/2015 10/12/15 @ 01:57 PM  09/29/15 @ 01:42 PM
16 |Approved Electronic I-9 N/A 1744998 No 0 11/3/2015 09/29/15 @ 02:10 PM  09/29/15 @ 02:10 PM
17 |Approved Electronic I-9 N/A 1745771 346587239 Yes U.S. Passport or Passport Card Department of State 37 3/7/2016 09/30/15 @ 08:01 AM 09/30/15 @ 08:01 AM
18 |Approved Electronic I-9 N/A 1745772 No 0 9/30/2015 09/30/15 @ 08:10 AM  09/30/15 @ 08:10 AM
19 |Approved Electronic I-9 N/A 1745775 No 0 9/30/2015 09/30/15 @ 09:28 AM  09/30/15 @ 09:28 AM
20 |Approved Electronic -9 N/A 1745778 346578 Yes U.S. Passport or Passport Card Department of State 37 9/20/2015 09/30/15 @ 12:00 PM  09/30/15 @ 12:00 PM
21 |Approved Electronic -9 N/A 1745787 Na 0 10/1/2015 10/01/15 @ 08:30 AM  10/01/15 @ 08:30 AM
22 |Approved Electronic I-9 N/A 1745788 441209749 Yes U.S. Passport or Passport Card Department of State 37 10/1/2015 10/01/15 @ 08:44 AM  10/01/15 @ 08:44 AM
23 |Approved Electronic I-9 N/A 1745802 23658756 Yes U.S. Passport or Passport Card Department of State 37 10/2/2015 10/02/15 @ 08:10 AM  10/02/15 @ 08:10 AM
24 |Approved Electronic I-9 N/A 1745804 No 0 10/2/2015 10/02/15 @ 11:55 AM  10/02/15 @ 11:55 AM
25 |Approved Electronic I-9 N/A 1745808 No 0 1/11/2016 10/05/15 @ 11:02 AM  10/05/15 @ 11:02 AM
26 |Approved Electronic I-9 N/A 1745836 No 0 10/7/2015 10/07/15 @ 07:25 AM  10/07/15 @ 07:19 AM
27 |Approved Electronic -9 N/A 1745837 441209749 Yes U.S. Passport or Passport Card Department of State 37 10/7/2015 10/07/15 @ 07:28 AM  10/07/15 @ 07:28 AM
28 |Approved Electranic I-9 N/A 1745899 13873049 Yes U.S. Passport or Passport Card Department of State 37 10/19/2015 10/13/15 @ 11:33 AM  10/13/15 @ 11:33 AM
25 |Approved Electronic I-9 N/A 1745920 No 0 10/15/2015 10/15/15 @ 07:23 AM  10/15/15 @ 07:23 AM
30 |Approved Electronic I-9 N/A 1765825 3457689 Yes U.S. Passport or Passport Card Department of State 37 1/1/2016 10/20/15 @ 08:49 AM  10/20/15 @ 08:49 AM
31 |Approved Electronic I-9 N/A 1765945 No 0 10/23/2015 10/23/15 @ 02:26 PM  10/23/15 @ 02:26 PM
Approved Electronic I-9 N/A 1766527 2354678 . Passport or Passport Card Department of State 10/27/2015 10/27/15 @ 11:43 AM  10/27/15 @ 11:43 AM
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For Additional Assistance

« Select Help from the vertical toolbar to access other
Guardian futorials.

For additional assistance contact your in-house
Guardian expert.
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Confidential User Guide

Please do not distribute this document outside of your
organization without our written permission.

Thank you.
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